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TITLE OF GRADUATION THESIS

Name SURNAME, Name SURNAME and Name SURNAME
Department of Aviation Electrics and Electronics
 Graduation Thesis

Advisor: Title. Name SURNAME

The word “smart” has been exercised in various fields. And it is widely accepted to mean intelligence. Smart home service, one of the typical emerging technologies in the IoT era. It has changed house equipment into being more intelligent, remote controllable, and interconnected. However, smart homes are still considered as a concepts in certain aspects. In addition, controllability of a smart home may differ according to users need. As number of smart home users are increasing in recent years and purposed solutions are diversifying, providing safe, useful solutions are getting more critical. In this thesis we are purposing a user friendly smart environment monitoring solution. This automation system can be designed by low power using components such as ESP32. This module has advantage for infused Wifi and bluetooth modules which lowers the connection costs by elimination of using external Wifi or bluetooth module. We will consider to use Wifi module more due to higher data transfer rate than bluetooth. In this thesis, we are proposing a dynamic system to control and monitor electronic sensors using a real time monitor and control platform, ubidots, which can be adapted easily home environment. This system can effectively reduce energy waste, increase habitant comfort and create more useful areas for peope who needs special care. By using ESP32 in this thesis, we can monitor the light, sound, temprature, humity, some toxic gas amount such as methane and carbon monoxide. This values can be viewed through mobile devices as well as web based cloud solution. The system is relatively inexpensive, easy to use and versatile for different environment. If the environment requires new measurements and actions, users can easily create basic events without programming knowledge.
Keywords: Keyword1, keyword2, keyword3, keyword4, keyword5

Do not forget to put blanks after the comma between the keywords.
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BİTİRME TEZİ BAŞLIĞI

İsim SOYİSİM, İsim SOYİSİM, İsim SOYİSİM

Havacılık Elektrik ve Elektroniği Bölümü
 Bitirme Tezi

Danışman: Ünvan. İsim SOYİSİM


"Akıllı" kelimesi çeşitli alanlarda kullanılmıştır. Ve zeka anlamına geldiği yaygın olarak kabul edilmektedir. IoT çağında ortaya çıkan tipik teknolojilerden biri olan akıllı ev hizmetidir. Ev ekipmanını daha akıllı, uzaktan kontrol edilebilir ve birbirine bağlı hale getirilmiştir. Ancak akıllı evler hala konsept bir kavram olarak değerlendirilmektedir. Ayrıca akıllı bir evin kontrol edilebilirliği kullanıcının ihtiyacına göre farklılık gösterebilir. Son yıllarda akıllı ev kullanıcılarının sayısı artarken ve amaca yönelik çözümler çeşitlenirken, güvenli, kullanışlı çözümler sunmak daha da kritik hale gelmektedir. Bu projede, kullanıcı dostu bir akıllı ortam izleme çözümü hedefliyoruz. Bu otomasyon sistemi, ESP32 gibi bileşenler kullanılarak düşük güçle tasarlanabilir. Bu modül, harici Wifi veya bluetooth modülünün kullanılmasını ortadan kaldırarak bağlantı maliyetlerini düşüren sistemde hali hazırda bulunan Wifi ve bluetooth modüllerini içerir. Bluetooth'tan daha yüksek veri aktarım hızı nedeniyle Wifi modülü kullanılacaktır. Bu projede, ev ortamına kolayca adapte edilebilen gerçek zamanlı bir izleme ve kontrol platformu olan Ubidots kullanarak elektronik sensörleri kontrol etmek ve izlemek için dinamik bir sistem öneriyoruz. Bu sistem, enerji israfını etkili bir şekilde azaltabilir, insan konforunu artırabilir ve özel bakıma ihtiyacı olan insanlar için daha kullanışlı alanlar yaratabilir. Bu projede ESP32 kullanarak ışığı, sesi, sıcaklığı, nemi, metan ve karbon monoksit gibi bazı toksik gaz miktarları takip edebilir. Bu değerler, mobil cihazların yanı sıra web tabanlı bulut çözümü üzerinden de görüntülenebilir. Ortam yeni ölçümler ve eylemler gerektiriyorsa, kullanıcılar programlama bilgisi olmadan kolayca temel olaylar oluşturabilir.
Anahtar Kelimeler: Anahtar kelime1, anahtar kelime2, anahtar kelime3, anahtar kelime4, anahtar kelime5
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SECTION 1
[bookmark: _Toc136060102][bookmark: _Toc38899480][bookmark: _Toc135845232]INTRODUCTION
[bookmark: _Toc136060103]Literature Survey
A detailed literature survey will be explained in this section. The literature should be well studied and previous studies should be handled carefully. You should include references and citations from similar works in your graduation project.
[bookmark: _Toc135845233][bookmark: _Toc136060104]Objective of Study
The objective of the graduation study will be briefly explained.
· Total length of Section 1 will not exceed 20 pages
· [bookmark: _GoBack]Early page of the Introduction part should be numbered as the first page.
· The explanations below are valid for all sections.
· The title of section (SECTION 1) style should be selected as section_principal. Numbers should not be written in front of this heading in the table of contents and at the beginning of the section.
· Heading (INTRODUCTION) style Heading 1 style should be selected. Numbers should not be written in front of this heading in the table of contents and at the beginning of the section.
· Sub-section (1.1 Literature Survey) style Heading 2 style should be selected.
· If there is a need for numbers in the titles, do not forget to correct the numbers and the title text as “Bold”. Put blank before headings.
[image: ]
[bookmark: _Toc97288783]Figure 1.1 The flow chart components



SECTION 2
[bookmark: _Toc136060105]YILDIZ TECHNICAL UNIVERSITY
The second part is given to you as an example for spelling rules. In this section, the methods you used in your study will be explained clearly. The software codes you use and all kinds of microprocessors, sensors, cards, development platforms, etc. The catalog information about the subject will not be included in the graduation thesis, but will be included in the appendices. The number of sections can be increased according to the content of the graduation thesis. In order to show the number of pages too much, no more space will be left than necessary, accordingly, the relevant figures will be added to the following page if necessary.
By selecting all content texts, line spacing options should be made Before: 6nk After: 6nk and Line Spacing: 1.5 lines. In figure texts, Line Spacing will be:1.
[image: ytü resimleri]
[bookmark: _Toc136046540][bookmark: _Toc136060125]Figure 2.1 General view of the campus
[bookmark: _Toc136060106]History (Subsection)
Yildiz Technical University is one of the seven government universities situated in İstanbul besides being the 3rd oldest university of Turkey with its history dating back to 1911. It is regarded as one of the best universities in the country as well. Our university has 10 Faculties, 2 Institutes, the Vocational School of Higher Education, the Vocational School for National Palaces and Historical Buildings, the Vocational School for Foreign Languages and more than 25,000 students. 
The Istanbul State Engineering and Architectural Academy and affiliated schools of engineering and the related faculties and departments of the Kocaeli State Engineering and Architecture Academy and the Kocaeli Vocational School were merged to form Yildiz University with decree law no.41 dated 20 June 1982 and Law no. 2809 dated 30 March 1982 which accepted the decree law with changes.
The new university incorporated the departments of Science-Literature and Engineering, the Vocational School in Kocaeli, a Science Institute, a Social Sciences Institute and the Foreign Languages, Atatürk Principles and the History of Revolution, Turkish Language, Physical Education and Fine Arts departments affiliated with the Rectorate. 
Yildiz Technical University is one of the seven government universities situated in ˙Istanbul besides being the 3rd oldest university of Turkey with its history dating back to 1911.It is regarded as one of the best universities in the country as well [1].
When citing references, as seen above, a space should be placed after the sentence ends. Citations should be made by selecting Add Citation>Add new source from the References menu. Include resources in IEEE format.
[bookmark: _Toc284942125][bookmark: _Toc284942523][bookmark: _Toc284942564][bookmark: _Toc286399791][bookmark: _Toc288724167][bookmark: _Toc288724482][bookmark: _Toc288731262][bookmark: _Toc525300324][bookmark: _Toc136060107]Faculties (Subsection)
Yildiz Technical University is one of the seven government universities situated in İstanbul besides being the 3rd oldest university of Turkey with its history dating back to 1911. It is regarded as one of the best universities in the country as well. Our university has 10 Faculties, 2 Institutes, the Vocational School of Higher Education, the Vocational School for National Palaces and Historical Buildings, the Vocational School for Foreign Languages and more than 25,000 students. 
[bookmark: _Toc284942127][bookmark: _Toc284942525][bookmark: _Toc284942566][bookmark: _Toc284943145]Subsubsection
Yildiz Technical University is one of the seven government universities situated in İstanbul besides being the 3rd oldest university of Turkey with its history dating back to 1911. It is regarded as one of the best universities in the country as well. Our university has 10 Faculties, 2 Institutes, the Vocational School of Higher Education, the Vocational School for National Palaces and Historical Buildings, the Vocational School for Foreign Languages and more than 25,000 students. 
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[bookmark: _Toc136046541][bookmark: _Toc136060126]Figure 2.2 Once, the UBF Circuit Laboratory.
Subsubsection
Yildiz Technical University is one of the seven government universities situated in İstanbul besides being the 3rd oldest university of Turkey with its history dating back to 1911. It is regarded as one of the best universities in the country as well[footnoteRef:1].  [1:  Our university has 10 Faculties, 2 Institutes, the Vocational School of Higher Education, the Vocational School for National Palaces and Historical Buildings, the Vocational School for Foreign Languages and more than 25,000 students.] 
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It is regarded as one of the best universities in the country as well.
Do not include equations as figures or text. Add them in a table format shown above. Consist the equations by selecting Equation from the Insert menu. Write the equation numbers as SectionNumber.EquationNumber in parentheses as seen above. The equation will be centre aligned and its number will be fully right aligned. Do not forget to refer to equation numbers in the text.
[bookmark: _Toc136060110]Subsubsection
Number of student number in departments is given in Table 2.1. Make sure that the table numbers are in the form of Table ChapterNumber.SubtitleNumber (If the Table label does not exist, a new label is added, in the Format tab, the ordering is adjusted according to the chapter number).
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	[bookmark: _Hlk60761903]DEPARTMENTS
	NUMBER OF STUDENT

	COMPUTER ENGINEERING
	1

	ENVIRONMENTAL ENGINEERING
	4

	ELECTRICAL ENGINEERING
	4

	INDUSTRIAL ENGINEERING
	2

	PHYSICS
	3

	CIVIL ENGINEERING
	4

	CHEMISTRY
	8

	MECHANICAL ENGINEERING
	5

	MATHS
	7


[bookmark: _Toc60778063]








SECTION 3
[bookmark: _Toc136060111]REALISTIC LIMITS, CONDITIONS AND CONSTRAINS TAKEN INTO CONSIDERATION IN THE DESIGN OF THE PROJECT
The study, research, and system design should examine the project's applicability and the real-life conditions and limits, and also the benefits and drawbacks, among other things.
· Any risk to the environment or individuals must be considered in the system's design. It must guard against dangers like as fire, leakage, and explosion. The chosen devices, their use, and the potential risks while dealing with, for example, electrical, magnetic, and electromechanical systems, as well as flame and gas sensors utilized in the system, must be considered.
· The initiative provides a safe and healthy habitat for both animals and humans.
· The primary goal of system design is to provide safer facilities. However, the number of security personnel could be reduced.
· The system's security is ensured by updated software that will be issued for the purpose of error elimination and steady operation. It also contains an automatic updating system. 
· In this project, the communication protocol 802.11g was used. The acquisition card ESP8266 was employed and FCC, CE, and TELEC commissions certify it.
Some key aspects to consider when studying, designing, and writing the final thesis, as well as when evaluating the submitted work, are:
	Phisical limitations, constraints and boundaries
	· Some limits, such as mechanical, electrical, and magnetic restraints. Friction, saturation, hysteresis, and other factors must be considered.
· Working space, trajectory, barriers, terrain, platforms, and other restrictions.

	Engineering norms and standards
	To design the project, important regulations, norms and standards must be considered. In the case of simulated work, real-world implementation difficulties should be addressed.

	Economic aspects
	· Information about how this study may benefit the community or country.
· Detailed information on the list of components and equipment, as well as costs, in order to establish a total budget.

	Environmental aspects
	Information about how the designed system may contribute to the community or country considering this aspect.

	Sustainability
	Information regarding how the intended system may benefit the community or country in this regard.

	Manufacturability
	Information regarding how the intended system may benefit the community or country in this regard.

	Health aspects
	· Information regarding how the intended system may benefit the community or country in this regard.
· I can state unequivocally that no human or animal was harmed throughout the course of this study.

	Security aspects
	Information regarding how the intended system may benefit the community or country in this regard.

	Ethical aspects
	I hereby declare that I obtained the necessary legal permissions during data collection and exploitation procedures, that I properly cited the references and made in-text citations, that I did not falsify and/or fabricate research data and study results, and that I abided by scientific research and ethics principles.
















SECTION 4
[bookmark: _Toc136060112]RESULTS AND DISCUSSIONS
The results obtained in the study will be given in this section. Tables and figures should be used to present the results. 
This section is also used to discuss and interprete the results obtained in the study. The results of the the study can be compared with other similar studies from the literature.
























SECTION 5
[bookmark: _Toc136060113]CONCLUSION
This section is used to conclude the study. It emphasizes the outcome of the work by relating it to the motivation.
Some key notes about thesis writing are given below. You should delete these ones before the submission


[bookmark: _Toc136060114]Writing
The graduation project should be written in passive sentences. For example, expressions such as “is obtained”, “is observed” and “is designed” should be used instead of expressions such as “I have obtained”, “I observed”, “I designed”.
The written language should be as simple as possible, technically focused and easy to understand. Long complex sentences should be avoided. Instead, short and clear sentences should be formed with the same meaning.
[bookmark: _Toc136060115]Punctuation
· Dot, comma, semicolon, colon, exclamation point and question mark are written adjacent to the word that precedes it and separately from the word that follows it.
· In punctuation marks, quotation marks, single quotation marks, parentheses, square brackets and curly brackets are written adjacent to the text they surround and separate from the outside text.
· Separator is written adjacent to both the word and the suffix.
· When referencing a specific section, figure, table or equation in the text, an appendix is written by placing a separator after the number. For example, it is used as “the block diagram of the system is given in Figure 4.2”, “this is obtained by combining equations (3.2) and (3.4)” and “as discussed in detail in Section 3”.
[bookmark: _Toc136060116]Citing
Another important point in graduation thesis writing is to cite the necessary and sufficient amount of citations. Not making enough references means owning someone else's opinion and is against ethical rules. For example, if a block diagram that describes the problem in the study very well is in another work in the literature and this figure will be added to the text, the figure text should be written in a way that includes references as “Figure 2.4 The problem aimed to be solved with the proposed system [8]”. If there is a determination taken from the literature in the sentence used, “According to a study conducted in 2013, only 15% of hospitals in Turkey are equipped with this type of medical equipment [15].” As in the example, the reference number is referred to at the end of the quoted sentence before the period. References to the sentence are written after the last word of the sentence, before the period, separately from the word and adjacent to the point.
[bookmark: _Toc136060117]Figures
· ‘Figure’ number and description of the figure are written under the figure.
· Figure number M is written as M.N, section number N and the order of the figure within the section. For example, figure 7 of chapter 1 is numbered "1.7".
· Figure caption should be written with a space of one character after the number, and only the first letter of the first word should be written in capital letters and the other words should be written in lowercase.
· In figures taken exactly from another source, reference is made to the relevant source at the end of the figure caption.
· Each figure must be cited and explained in the text.
[bookmark: _Toc136060118]Tables
· The table must be centered on the page.
· 'Table' the number of the chart and the explanation of the chart are written on the top line of the chart.
· The table number is written as M.N with M being the section number and N being the order of the figure within the section. For example, chart 5 of chapter 2 is “2.5.” is numbered.
· In the table caption, only the first letter of the first word should be written in capital letters and the other words should be written in lowercase letters, leaving a space of one character after the number.
· In tablees taken exactly from another source, reference is made to the relevant source at the end of the table caption.
· Each table must be cited and explained in the text.
[bookmark: _Toc418675675][bookmark: _Toc136060119]Equations
The equation number is written in parentheses, M is the section number and N is the order of the equation in the section (M.N) at the end of the line. 
Add them as a table format shown below:
	
	(5.1)


· 
[bookmark: _Toc136060120]REFERENCES
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If you add numbered citations in the text with the Add citation menu, if you right-click on the source table above and select Update field, all sources will be listed. After the table is updated, select the text in the table and choose the style of the Bibliography. Include references in IEEE format. There are some examples give above: web site  [1], conference paper [2], academic journal paper [3], text book [4].
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If you don't have any attachments, you can delete this section.
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